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All Fares 
 
What is All Fares? 
 

Amadeus All Fares allows travel agents to search, compare and book low fares from both 

GDS and non-GDS sources, making it easy to compare and book air deals. Amadeus All 

Fares is web-based and fully integrated at the point of sale for improved productivity and 

customer service. 

 
Key benefits 

 
✓ Save time, eliminate errors: Handles all information and transactions for processing 

voluntary ticket exchanges; formats tickets for reporting. 

 

✓ Gain fast, accurate results: Determines appropriate fare, taxes, penalties and residual 

(re fund) values; dates all fare and ticketing elements. 

 

✓ Reduce debit memos: Transactions are covered by Amadeus Fare Policy 
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How to access All Fares 

 
In Amadeus Selling Platform Connect, you can access All Fares in three different ways: 

 

1. Click on New command page in the toolbar and select the Air option. 

 

2. From the Booking File or Command page, click on the plane icon in the Go To section. 

 
 

3. From the File menu, select New Booking File, then click on the Air link. 
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The Your air search page opens, allowing you to search and book Amadeus GDS and non-

GDS fares.  

 

The Itinerary, Passenger and Fares and fees sections can be set up to be collapsed or 

expanded by default. 
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How to search for a flight 
 

1. Select the type of search you want to do, either Standard search or Flexible dates. 

 

 
 

2. In the Itinerary section, fill in all mandatory fields (marked with *): 

- In the From and To fields, enter the departure and arrival information. 

- In the Date field, enter the departure date. 

- Complete the optional Time, Cabin and Airlines and alliances fields, if required. 

 

Note:  

- To exclude an airline, in the Airlines and alliances field, type a minus sign (–) and 

select the airline from the drop-down list. 

- Select the No connections check box to search for flights with no connections. 

- Click on the recycle bin to remove either the inbound or outbound segment. 

- Click on the plus (+) sign to add a bound. 

 

 

 
 

3. In the Passengers section, enter the number of passengers for each passenger type 

code. 
 

 
  

 Note : Click on Add passengers to find more passenger type codes. 
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4. In the Fares and fees section click drop down list to 

- Select the Fare Types that you want. 

- Enter the currency in the Currency field. If needed, add any fare restrictions to the 

Fare Restrictions field. 

- Select the Baggage included and Withhold taxes check boxes, if required. 

- Select the Content options that you want. 

- Tick NDC promotion code and Enter an NDC promotion code, If required. 

 

 
 

5. Click on Search. 

 

 
 

The Results page opens.  

 

The content source is shown. All Fares offer content from multiple sources, including ETK 

(Edifact Ticketing) and NDC (New Distribution Capability). The content type is indicated by 

a badge, for exam ple: 

 

Example : Search result : Itinerary –NEW! 
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Example : Search result : Price 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Edifact Contents 

  
 

NDC Contents 
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How to search with flexible dates 
 

In the Your air search section, indicate how you want the recommendations displayed. 

 

• If you select Standard search, the fare recommendations are shown for the selected 

itinerary date only. 

• The cheapest fare at the top. 
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• Click Fare Box to see Price details, , Details per passenger and Full fare conditions. 
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• If you select Flexible Dates, a +/- 3 days calendar view is shown. 

The green shaded boxes show the lowest fares. The box with the blue outline shows the 

fare for the actual dates in your search. 

 

 
 

 
 

▪ Select your preferred fare from the +/- 3-day calendar by clicking on it. 

▪ Click on X to go back to the list or click on Continue to proceed with booking your flight. 
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Understanding the Results page 
 

The search results are displayed with the cheapest fare at the top. 

 

E 
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 Airline and flight number. 

  

 Closs price details 

 
 

  

  

  

 

How to display flight information from the All Fares results  
 

1. Click Fare Box to see Price details, , Details per passenger and Full fare conditions. 

2. Click on the flight number. 
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3. Click on Close (X) when finished. 

 

 
How to filter the All Fares results 
 
In the search results, the Filter tab is on the left. 

 

1. Use the sliders to specify a range of values where applicable (or enter the values 

directly). Only the results that match the selected filter(s) remain displayed. 

 

2. For check box options, select accordingly. The list of results is updated automatically. 
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How to compare fares 
 
Some fare recommendations may also display a list of available upsells. 

 

1. In the Results page, To display the fare comparison table, click on Compare all fares. 

 

   
 

The Compare your fares matrix is displayed. It contains the services offered by each 

Fare Family or a comparison of the same recommendation from different content 

sources. 
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2. To check the meaning of the icons, click on Legend. 

 

 
 

3. To go back to the results, click on the Back to results button. 
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How to book flights 

  

 

 



All Fares & NDC Content 

THAI Amadeus Learning Centre         Page 16 of 90  
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All Fares & NDC Content 

THAI Amadeus Learning Centre         Page 19 of 90  

  



All Fares & NDC Content 

THAI Amadeus Learning Centre         Page 20 of 90  

How to switch between the command page and graphic mode 
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How to reserve Seats and Services 
 

In the What do you want to do next? section of the booking file, click on Add Seats or 

Add Services. 
 

 

 

How to reserve a seat 
 

1. In the What do you want to do next? section of the booking file, click on Add Seats. 

The Seat map is displayed. 

 

2. To reserve a seat for a passenger, click on the seat. 

When a seat is selected, the passenger number appears in the seat icon, and the selected 

seat will be displayed in the Passengers section.  
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3. Click on Book Seats to finalize the seat reservation. The status of the seats will change to 

Confirmed. 

 

 
 

4. Then select return segment. click on a seat to select seat for the return flight. Click on 

Book Seats. 
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5. To return the booking file, click Close seat map. 
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How to add a service 
 

1. In the What do you want to do next? section of the booking file, click on Add Services. 

The Services catalog tab opens, displaying the service categories available for the 

booked flight. 

 

2. Click on the service category requested by the passenger to know the price and to book. 

 

Example : Meal Request  

 

 

 

 

 

3. Select the service details for the required passengers and segments. Click on the plus sign 

(+) to expand a service. 

 

4. If the service requires more information, enter the information in the Additional details. 

section. Make sure all mandatory fields highlighted in yellow are completed. 
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Example : Passenger Information > Passenger IROP contact information 

 

  
 

5. Click on Request (or Add Service). 

 

The price is displayed in the Services catalog and in the Special Services Request (SSR) 

and Auxiliary Services (SVCs) section of the booking file. 

 

 
 

6. To return the booking file, click Close. 

  



All Fares & NDC Content 

THAI Amadeus Learning Centre         Page 27 of 90  

Section in the Booking File  
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NDC (New Distribution Capability) 
 

What is NDC? 
 

NDC (New Distribution Capability) is a new way to sell personalized trips. It gives you access 

to: 
 

• Additional content from airlines 

• Bundled services 

• Upsells and ancillary services 

• Simplified Booking flow 

• Reduced ADM due content validated by Airline 
 

Here is the Booking flow of “Existing GDS” & “New NDC-Based” 
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Prime booking flow – NDC 
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How to access NDC Content? 
 

You can access all NDC content from All Fares in Selling Platform Connect. To start a search: 

 

- Click on New Booking File in the toolbar and select the Air option. 

 

 
 

 

- From the Booking File or Command page, click on the aircraft icon in the Go To section. 

 

 
 

- From the File menu, select New Booking File, then click on the Air link. 
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The Your air search page opens, allowing you to search and book Amadeus GDS and NDC 

Content.  

 

The Itinerary, Passenger and Fares and fees sections can be set up to be collapsed or 

expanded by default. 
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Booking flow 
 

Itinerary checking 
 

1. In the Itinerary section, complete all mandatory fields and other required information. 

 

 
 

Passenger 
 

2. In the Passengers section, select the number for each passenger type. You can search 

by Discount Pass, Corporation ID and Frequent Flyer number. 

 

 
 

Fare and Fees 
 

3. In the Fares and fees section, select the type of fares, such as public or negotiated. 

You can add multiple corporate codes or an NDC-specific airline promotion code (only 

valid for SQ for the moment). You can search for NDC content only or exclude NDC 

content. 

 
 

4. Click on Search. The Results page is displayed. 
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Understanding the NDC Results page. 
 

In the Results page, you can use filters to refine the results. The following elements indicate 

that you are looking at NDC content: 

 

Example : Search result : Itinerary –NEW! 

 

 
 

   

 

A 

B 

C 
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Example : Search result : Price 

 

 
 

 
 

A 

B 

C 

D 
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A Warning message. 

B NDC badge. 

C 
Offer valid on 30 mins only. Each time when you click on any link, for exam ple, 

Fare details, the clock is restarted. 

D Specific NDC content only. 

 

 

Display Fare information and services are included. 

 
1. Click Fare Details (Public fare, Private fare, Negotiated fare) to see Price breakdown, 

Details per passenger and Full fare conditions. 
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Details per passenger: 

 

 
 

Tax details: 
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Full fare conditions: 
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Some NDC offers include a list of available upgrades. Click on Show more fares to see its 

details or when display fare details. 
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To display the flight information and fare family description expand one of (or each) 

flight direction section. Click on  

 

 
 

.  
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Flight Information:  
 

 
 

Baggage information: 
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Show Details: 
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How to book flights 
 

1. In the Results page, click on Select flight. 

 

 
 

The Booking summary page is displayed. It shows the itinerary details, the passenger 

information, the contact information and the price details. 

 

Booking Summary 
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2. If needed, add the passport or the frequent flyer information in the Passenger 

information section. 

 

Note: This information cannot be added later in the process. 

 

Passenger Information 
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Both Travel documents and Frequent Flyer MUST enter information at this stage. It 

won’t be possible to add this information later (in the Booking File). This is very important 

for itineraries where the Secure Flight program applies, as you won’t be able to issue 

tickets (request issuance of the tickets). 
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Contact Information 

 

At least one passenger contact (email, mobile or phone) and choose to share the contact with 

the airline to inform about schedule changes or not. 

 

Note: You won’t be able to enter passenger contact in the Booking File. 

Passenger information cannot be changed after order creation. 

 

  
 

Price Details 

 

In the Price details section, review the fare breakdown. 
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3. When you are ready to book the offer, review all the information you have entered and 

then click on Book. 
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The Booking file page is displayed. 

 

− If required, modify the Request received from (RF) field. By default, this field is pre filled 

with your user login. 

− To add the ticketing arrangement, click on Add. 

 

 
 

 
 

− To finalize the booking, click on Save & Confirm (ER). 
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Section in the Booking File  
 
Booking File Information 
 

• An NDC badge and Amadeus record locator are displayed. 

• The N D C  Order ID is used for reconciliation purposes or when an agent 

needs to contact the airline's call center for support. 

• The airline record locator is usually used when checking in at the airport or online. 

 

  
 

Products 
 

- You can expand a flight trip in the Products section to view the details for each 

segment part of the flight in the Itinerary tab. 

- NDC content is highlight by the NDC badge. 
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- The Price tab shows each passenger in the booking, with the fare details. 

 

 
   

Ticket deadline 
 

 
 
Special Services Requests (SSRs) and Auxiliary Services (SVCs) 
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Passenger and contact details 
 

 
 

When on the Graphic Mode, click on Show in Command page in the side panel to switch 

between the command page and graphic mode. 
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Booking Retrieval 
 

Retrieving a Booking by Amadeus Record Locator 

Agents can retrieve a Booking for which they are responsible, by entering: 
RT 6MOZQJ 

 
RT  Transaction Code 

6MOZQJ  Amadeus Record Locator 

 

 
 

Retrieving a PNR by Surname or Partial Name  

This entry is limited to the office with responsibility for the PNR. For an exact search, enter the 

full name. For example: 

RT/AMADEUS 

 

RT   Transaction Code 

/AMADEUS  Slash Followed By Surname 
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All other actions related to an NDC order (air content) will continue to be available only in 

graphic mode. 

 

If user enters a cryptic command for an air segment with NDC content, the error message 

“RESTRICTED ENTRY” is displays. 

 

   
 

Users will be able to enter cryptic commands for non-air segments. Example : 

 

LP   – List PNRs 

AP  – Contact element (no update to A/L)  

RH  – History element 

RM  – Adding remarks 

QE  – Queue element   

TQT,TQM – Display TST,TSM 

IEPJ  – Print The Itinerary 

ITR  – Print E-Ticket ITR 
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Ancillary Services 
 

How to add seats and services for NDC bookings 

 

Click on the button “Add Seats” or “Add Services” in the Product section to reserve seat 

or other ancillary services such as baggage. 

 

  
 

Seat map  
 

 In the Product section of the booking file, click on Add Seats. The Seat map is 

displayed. 

 

 To reserve a seat for a passenger, click on the seat. 

When a seat is selected, the passenger number appears in the seat icon, and the selected 

seat will be displayed in the Passengers section.  
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 Click on Book Seats to finalize the seat reservation. The status of the seats will change to 

Confirmed. 

 

   
 

 Then select return segment. click on a seat to select seat for the return flight. Click on 

Book Seats. 
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 To return the booking file, click Close seat map. 

 

 
 

Service Catalogue 
 

 In the Product section of the booking file, click on Add Services. The Service catalogue 

is displayed. 

 

 Click on the service category requested by the passenger to know the price and to book. 

 

  
 

 Click on Request.  
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 Click on Close service list , System will go back to a Booking file. 
 

 
 

Special Service Request (SSRs) and Ancillary Services (SVCs) 
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Product Section 
 
To display the Itinerary and Price (TST) description expand one of (or each) flight direction 

section. Click on     .  

 

ITINERARY 

 
 

PRICE 
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Expand TST or TSM Click on “View TST” or “View TSM” 

 

   
 

TST 
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TSM 
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Transfer order to Ticketing office 
    (In case of non-ticketing agencies) 

 
ES BKKOK219W -B 

 

ES   Security agreement transaction code 

BKKOK219W Office identification of the Ticketing office 

– B   Dash followed by the access mode 
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Then save PNR by  RF PAX ;  ER 
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How to pay and issue the ticket 
 

Note: Before issuing the ticket, review the flight details. 

 

1. In the Products section, select the flight and click on Issue and pay or select Issue and 

pay from the drop-down list. 
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2. The Review and issue your NDC Content page is displayed. 

 

  
 

3. In the Form of Payment section, select the payment type (Cash) 

4. Click on Issue and pay again. 
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NDC Booking file with ticket 
 

A message and the new ticket number confirm that NDC content was paid and issued.   NDC 

tickets and EMDs are displayed in the E-Ticket and EMD section of booking file. 

 

 
 

E-Ticket Record:  
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In the command page: 
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How to send document receipt 
 

Note: E-ticket receipts (ITR) for NDC bookings can only be issued after the ticket issuance 

or exchange. 

 

In the E-Ticket and EMD section, click on Issue Document Receipt. 
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Send E-ticket Receipt. 

 

  

 
 

You can send ITR to email address in the command page by entering: 

 

ITR-EML-ALC@THHAIAMADEUS.COM 
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How to split a passenger from an NDC booking 

 
You can now split a passenger from an NDC booking to partially exchange or refund a ticket 

or to split up passenger information. 

 

To split a passenger from an NDC booking: 

 

1. Retrieve the booking file. 

2. In the Passenger and contact details section, click Split NDC Order. 

 

  
 

The Split NDC Oder window opens. 
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3. Select the passenger you want to split from the PNR and click the Split NDC Order button. 

 

  
 

In the Split completed window, the split PNRs are shown with their reference numbers. 
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piyathida@thaiama... - THAI-Amade... 
 

4. Select the PNR you want to display and click the Continue button. 

 

  
 

The associated PNR reference is displayed in the Booking file information section. 

 

  
 

The associated PNR reference is shown as an SP element in the cryptic mode. 
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How to cancel an NDC booking 
 

Note: The PNR needs to be saved before you can cancel a booking. 

 

1. In the Products section, select the flight you want to cancel. All segments of the flight are 

automatically selected. 

 

2. Click on Cancel Order or select Cancel Order from the drop-down list. 

Depending on the situation and the airline, the order is cancelled, refunded or voided. 

 

Cancel before ticketing – Cancel Order 
 

o If no ticket has been issued, the order is cancelled. 
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Cancel after ticketing – Void (Same day) 
 

o If the airline considers the cancellation to be a void, it cancels the itinerary. 
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Refund 

 
o If the airline considers it to be a refund, the refundable amount is displayed. 
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How to exchange an NDC ticket 

 
1. In the Products section, select the flight to be exchanged. 

 

2. Click on Exchange or select Exchange from the drop-down list. 
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3. Select the new flight date and details, click Search new flights. 

 

  
 

 

Result – Different results for selection 

 

Ex. No additional fare, with fee only: 
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Ex. Additional fare and fee: 
 

   
 

4. Click on Select flight to exchange the itinerary. 
 

5. Verify and reissue. 
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6. Check form of payment (Cash), Click on Reissue. 

 

 
 
After exchanged. 
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Working with queues for NDC content 
 

There are dedicated queue categories for NDC order change notifications: 

 
- QAC0C256-258 

 
- QAC1C256-258 

 
- QAC7C256-258 
 
- QAC8C256-258 

 
When is queue placement triggered? 
 

• Flight time change: 
- The flight segment time is updated in record and the status changed to TK. 
- The record is queued in Q7C257. 

 

• Involuntary flight schedule change: 
- The cancelled segment status is updated to UN and a new flight segment is 

added with status TK. 
- The record is queued in Q7C257. 

 

• Involuntary schedule cancellation: 
- The cancelled segment status is updated to UN. The record is queued in Q7C257. 
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NDC Sale Report Solution  

(only the Query and Transactions reports : TJQ) 
 

NDC sales performed by travel sellers are currently not inserted into our Sales Report database. 

As a result, travel sellers do not have the capability to display their NDC sales through the 

legacy Query sales reports. 

 

With this enhancement, we introduce the capability to enable Amadeus travel sellers to display 

their NDC sales in the Amadeus Travel Platform using our legacy Query sales reports (TJQ). 

 

Every ticketed NDC transaction (prime booking issuance of e-tickets and EMDs, 

exchange/reissue, refund, void) can now be displayed through the legacy Query sales 

reports (TJQ), enabling our travel sellers to reconciliate their sales easily. 

 

Some new filtering options have also been created for Query sales report to facilitate 

the reconciliation of NDC sales more efficiently. 

 

Query report containing both EDIFACT GDS and NDC sales: 
 

TJQ/SOF/D-05AUG 

All Edifact and NDC Ticketing transactions done on the 05th of AUG 
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TJQ/SOF/D-05AUG/NDC 

All NDC reported Ticketing transactions done on the 05th of AUG 
 

 
 

TJQ/SOF/D-05AUG/ETK 

All Edifact Ticketing transactions done on the 05th of AUG 
 

 
 

 

Some additional examples using different qualifiers: 

Example to display only NDC void transactions:  TJQ/SOF/NDC/ALL/QTC-CANX 
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Some additional examples using different qualifiers: 

Example to display only the NDC EMDs reported to : TJQ/SOF/D-03APR/NDC/QTC-EMDA 

 

 
 

 
 

Note: The new Query report filtering options can be combined with the following qualifiers: 
Security (S), Currency (C), Date (D), Selection (Q), Void (V), From (F), Display Reverse Order (R). 
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Amadeus Service Hub 
 

Click here to access Amadeus All Fares - Entry Point. 

 

 

https://servicehub.amadeus.com/c/portal/view-solution/270679059/amadeus-selling-platform-connect-all-fares-entry-point
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Click here to access How to work with NDC 

 

 
  

https://servicehub.amadeus.com/c/portal/view-solution/1024930876/new-distribution-capability-ndc-how-to-work-with-ndc
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Click here to access NDC Entry Point. 

 

 
 

 

https://servicehub.amadeus.com/c/portal/view-solution/437647081/amadeus-selling-platform-connect-ndc-entry-point?redirect=/group/central/search?q=ndc%2520entry%2520point
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